Power Factor Correction on
UCC28070EVM Using C2000
Piccolo-A

CCS User Guide

Version 1.1
June 2010



Implementing Power Factor Correction with C2000
Micro-controllers

Abstract

This document presents the implementation details of a digitally controlled Power Factor
Correction (PFC) system. This forms the first stage of a rectifier system. The 300W
UCC28070EVM analog reference design system is used to provide a means to learn
and experiment digital control with C2000 controllers. Instead of using a UCC28070
control card to control this EVM, a C2000 Piccolo-A control card is used here. This
provides for an easy way to control the same power stage using an analog or a digital
solution from Texas Instruments.

With various regulations limiting the input current harmonic content, especially with the
IEC 61000-3-2 standard that defines the harmonic components that an electronic load
may inject into the supply line, a Power factor correction stage has become an integral
part of most rectifier designs. This stage forms the front end of a rectifier system as
shown in Fig 1.
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Figure 1. System Block Diagram

The phase shifted full bridge converter is used in DC-DC conversion, for example in
telecom systems to convert a high voltage bus to an intermediate distribution voltage,
typically closer to 48V. The phase shifted full bridge (PSFB) stage provides the voltage
translation as well as the isolation from the line voltage, since the PSFB topology
includes a transformer. This stage forms the second stage of the rectifier system as
shown in Fig 1. This document focuses on the PFC stage.

The transition to digital power control means that functions that are previously
implemented in hardware are now implemented in software. In addition to the
intelligence and flexibility this adds to the system, this simplifies the system
considerably.

This paper presents the hardware design and its corresponding software to control a
two-phase interleaved power factor correction front end. It also implements a method to
improve the input power factor (p.f.) and total harmonic distortion (T.H.D.) under low load
and/or High Line conditions.
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1.2

Introduction

The function of a PFC stage (sometimes called a pre-regulator) is to generate an
intermediate DC bus from the AC source while drawing a sine wave input current. We
begin to examine the functions of such a system in some detail.

Motivation

Of course, the question as to why a PFC stage is needed has not been answered yet.
To understand this, a typical AC-Rectifier Input Circuit is shown in Fig 2a. For simplicity,
consider the load being resistive. A sketch of the bridge rectifier input current (Fig 2b)
shows that this is dominated by pulses that correspond to the time when the output DC
bus capacitor is being charged. A Fourier analysis of the waveform shows the presence
of harmonics in the line current. In a practical rectifier, the DC-DC converter stage acts
as a load to the PFC stage. This represents a non-linear load and will draw harmonic
currents from the line.

Voltage Load

AC Line l

Current e - e -

A A

® ®
Figure 2. a) Typical AC Rectifier Input Circuit b) Input current waveform

These harmonics present a two-fold difficulty. Firstly they represent reactive power,
which results in losses, and secondly, such currents can distort the line voltage. To avoid
these undesirable effects, PFC attempts to draw a sinusoidal current from the line that is
exactly in phase with the line voltage.

PFC Stage Implementation on the ACDC Board

At first, passive PFC solutions were used to achieve PFC, especially in higher power
applications. However, these solutions required bulky 50/60 Hz Iron core inductors.
These were replaced by Active PFC solutions that employed boost regulators and
average current mode control techniques for wave shaping the input current. The boost
converter switches at a much higher frequency (tens/hundreds of KHz) compared to the
line frequency reducing the input filter and the boost inductor size drastically. Further
improvements may be obtained by implementing an interleaved boost converter
topology. This reduces the input current ripple, increases efficiency, reduces stress on
power electronic components and also results in reduction in the overall inductor
volume.
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Fig 3 shows the simplified block diagram of the PFC circuit implemented here. The input
AC line is passed through an EMI filter, and then through a bridge rectifier. The next
stage is a two phase interleaved boost converter that boosts the AC line voltage, to the
DC bus voltage. Inductor L1, MOSFET switch Q1 and diode D1, together, form phase A
of the boost circuit, while L2, Q2 and D2 form the phase B. Finally a capacitor at the
boost converter output acts as an energy reservoir, which reduces the output voltage

ripple.
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Figure 3. Two phase Interleaved PFC

The control algorithm is implemented on a C2000 micro-controller (MCU). The MCU
interacts with the hardware by way of the feedback signals and the PWM outputs. The
guantities that are sensed and fed back to the MCU include, the rectified input AC
voltage (Vrect ac), the two PFC phase currents (Ipna, lphs), and the boost stage output
voltage (Veec_our), @s shown in Fig 3. The duty cycle of the PWM outputs driving the two
switches determines the amount of boost imparted by the boost converter. This is the
controlled parameter.

MCU achieves PFC by controlling this duty cycle in a way such that the rectified input
current, which is nothing but a numerical addition of the two phase currents, is made to
follow the rectified input voltage while providing load and line requlation at the same
time.

This is made possible by the high frequency PWM modules, an equally high control loop
frequency and a 12-bit on chip ADC available on C2000 Micro-controllers. A detailed
description of the software algorithm is provided in the following chapters.

PFC Electrical Specifications

Following lists the key highlights of the UCC28070 EVM.
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Input Voltage (AC Line): 85V (Min) to 265V (Max)
390Vvdc Output

300 Watts Output Power

Full Load efficiency greater than 90%

Power factor at 50% or greater load — 0.9 (Min)
2-phase Interleaved Boost Circuit Topology

200kHz switch frequency, each phase

V V ¥V ¥V V¥V V V V

Phase-shedding capable

Software overview

Software Control Flow

The PFC2PHIL project makes use of the “C-background/ASM-ISR” framework. It uses
C-code as the main supporting program for the application, and is responsible for all
system management tasks, decision making, intelligence, and host interaction. The
assembly code is strictly limited to the ISR (Interrupt Service Routine), which runs all the
critical control code and typically this includes ADC reading, control calculations, and
PWM updates. Fig 4 depicts the general software flow for this project.

C Environment Assembly

! Context Save

Initialisation
28x Device level
Peripheral level

System level
ISR, ADC Wave-Shaping Calculations
EM Average
Inv Avg Sqr
| | Background Loop | | PFC ICMD
| PFC Current loop |
| Background Loop | PFC Voltage loop |
DATALOG
v v v
Timer 1 Tasks: Timer 2 Tasks: Timer 3 Tasks:
Slew Limit Instrumentation, Communications ontext Restore
Start-up/Shut-down

[ exir ||

Figure 4. Software flow
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The key framework C files used in this project are:

PFC2PHIL-Main.c — this file is used to initialize, run, and manage the application. This is
the “brains” behind the application.

PFC2PHIL-Devinit_F2802x.c — this file is responsible for a one time initialization and
configuration of the F2802x device, and includes functions such as setting up the clocks,
PLL, GPIO, etc.

The ISR consists of a single file:

PFC2PHIL-DPL-ISR.asm — this file contains all time critical “control type” code. This file
has an initialization section (one time execute) and a run-time section which executes
(typically) at the same rate as the PWM time-base used to trigger it.

The Power Library functions (modules) are “called” from this framework.

Library modules may have both a C and an assembly component. In this project, seven
library modules are used. The C and corresponding assembly module names are:

C configure function ASM initialization macro ASM run-time macro
PWM_PFC2PhiL_Cnf.c | PWMDRV_PFC2PhIiL_INIT n | PWMDRV_PFC2PhiL n
ADC SOC Cnf.c ADCDRV_4CH_INIT m,n,p,g | ADCDRV 4CH m,n,p,q
PFC_INVSQR_INIT n PFC_INVSQR n
MATH_EMAVG _INIT n MATH_EMAVG n
PEC ICMD INIT n PEC ICMD n
CNTL_2P2Z INIT n CNTL_2P2Z n
DLOG_4CH_INIT n DLOG_4CH n

Table 1. Library Modules

The control blocks can also be represented graphically as below. (Fig 5)
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ADCDRV_4ch:1,2,4,5:

PWMDRV_PFC2PhiL: 1:
RItPtrA ADC A2
PFCDuty P - PWMIA > RItPtrB
W T A [€— ADCA1
- D
PFCShareAd; M1 bwmie » VacLineRect RItPtrC C «— ADC A4
Period
VpfcOut RItPtrD ¢— ADC A3
CNTL_2P2Z:1:
Pfclemd
Out —{ PFCDuty | Out VpfcVemd
IpfcTotal £1 Fdbk VpfcOut £1 Fdbk
DBUFF
—> —>
CNTL_2P2Z_CoefStruct CNTL_2P2Z CoefStruct
B0 BO
Bl Bl
B2 B2
Al Al
A2 A2
Dmin Dmin
Dmax Dmax
MATH_EMAVG:1: MATH_EMAVG:2:
VacLineGainScaled VacLineScaled Ipfc_avg IpfcTotal
Multiplier Multiplier
PFC_ICMD:1: PFC_INVSQR:1:
VpfcVemd
InvAvgSqr VacLineGainScaled
InvAvgSaqr 0 VinvSqr Out € Pfclemd <€4—=8 Out In C
VacLineScaled 0 VacRect ]
- Vmin
VmaxOverVmin VminOverVmax

DLOG_4CH
VacRect i1Ptr buff1Ptr —>[IIIIIII DBUFF1
InvAvgSar i2Ptr buff2Ptr [ITTTTTTTT] DBUFF2
Pfclcmd 3Pt Size buff3Ptr [T DBUFF3

TrigVal

PreSealar buff4Ptr DBUFF4

VpfcOut i4Ptr

Figure 5. Software blocks

Notice the color coding for the modules in Fig 5. The blocks in ‘dark blue’ represent the
hardware modules on the C2000 controller. The blocks in ‘blue’ are the software drivers
for these modules. The blocks in ‘yellow’ are part of the mathematical processing carried
out on various signals. Although a 2-pole 2-zero controller is used here, the controller
could very well be a PI/PID, a 3-pole 3-zero or any other controller that can be suitably
implemented for this application. Also notice the purple colored block used for logging
data of up to four system parameters at a time. Such a modular library structure makes it
convenient to visualize and understand the complete system software flow as shown in
Fig 6. It also allows for easy use and additions/deletions of various functionalities. This
fact is amply demonstrated in this project by implementing an incremental build
approach. This is discussed in more detail in the next section.
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Figure 6. Control Flow

The system is controlled by two feedback loops. The outer voltage loop regulates the
output DC voltage, while a faster inner current loop wave shapes the input current so as
to maintain a high power factor at the input. Fig 6 also gives the rate at which the control
blocks are executed. For example, the current controller is executed at a rate of 100 kHz
(half of the PWM switching frequency) while the voltage controller is executed 2x slower.
The sensed signals, which were shown in Fig 3, Vrect ac, lphas lphs @nd Vpec our are
properly conditioned and fed back to the 4 ADC channels of the C2000 controller.
Following explains the control implemented above.

The sensed output voltage is compared with a slewed version (VpfcSetSlewed) of the
voltage reference command (VpfcSet) in the voltage controller. The voltage controller
generates an output so as to regulate the system output voltage. The input current
(IpfcTotal) is a numerical addition of the two phase currents. These currents are
measured in the two MOSFET legs for the two phases. Also the 0.2V offset on the
current sense on this board is accounted for in the software. Thus the desired sensed
input current (IpfcTotal) is a rectified sine wave that is in phase with VacLineRect. To
achieve this, the current reference command (Pfclcmd) is derived by multiplying the
voltage command (VpfcVemd) with the scaled version of input voltage (VacLineScaled)
and the inverse square (InvAvgSqr) of the average input (scaled) rectified voltage. This
last factor (InvAvgSqgr) normalizes the input to its own maximum and also provides a
feed-forward compensation to maintain a constant output power for a given load by
appropriately responding to changes in the input AC voltage.

Although it has not been implemented here, a phase management block can be added
to this control flow. This provides a means to share the load between the two phases
and facilitates ‘phase shedding’ to increase system efficiencies at low loads. In the
implemented software, the control command is equally shared between the two phases
by driving equal duty cycles for the two switches Q1 and Q2, thereby closely sharing the
load between the two phases.
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Incremental Builds

This project is divided into two incremental builds. This makes it easier to learn and get
familiar with the board and the software. This approach is also good for
debugging/testing boards.

The build options are shown below. To select a particular build option, set the macro
INCR_BUILD, found in the PFC2PHIL-Settings.h file, to the corresponding build
selection as shown below. Once the build option is selected, compile the complete
project by selecting rebuild-all compiler option. Next chapter provides more details to run
each of the build options.

Incremental build options for PFC

INCR_BUILD =1 Open loop check for boost action and ADC feedback (Check
sensing circuitry)

INCR_BUILD =2 Full PFC

Table 2. Incremental build options for PFC
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Procedure for running the incremental builds

The main source files, ISR assembly file and the project file for C framework to bring up
the PFC system are located in the .\controlSUITE\development_kits\HVPFC2PhiL\
PFC2PhilL directory. The projects included with this software are targeted for CCSv4.

Warning

There are high voltages present on the board. It should only be handled by experienced
power supply professionals in a lab environment. To safely evaluate this board an
isolation transformer should be connected between the AC source and the unit. Before
AC power is applied to the board a voltmeter and an appropriate resistive or electronic
load must be attached to the output. The unit should never be handled when the power
is applied to it or when the output voltage is greater than 50V. There is no overvoltage
protection implemented on the board and therefore zero load or very low load operation
is highly discouraged.

Follow the steps below to build and run the example included in the PFC software.

Build 1. Open loop boost with ADC measurements
Objective

The objective of this build is to evaluate the 2 phase interleaved PFC PWM and ADC
driver modules, verify the PFC MOSFET driver circuit and sensing circuit on the board
and become familiar with the operation of Code Composer Studio (CCS). Since this
system is running open-loop, the ADC measured values are only used for
instrumentation purposes in this build. Steps required to build and run a project will be
explored.

Overview

The software in Buildl has been configured so that the user can quickly evaluate the 2
phase interleaved PFC PWM driver module by viewing the various waveforms on a
scope and observing the effect of change in duty cycle on the output voltage by
interactively adjusting the duty cycle on CCS. Additionally, the user can evaluate the 2
phase interleaved PFC ADC driver module by viewing the ADC sampled data in the
watch view and also by using the CCS graphical capabilities.

The PWM and ADC driver macro instantiations are executed inside the DPL_ISR as
mentioned in the previous chapter. Fig 7 shows the software blocks used in this build.
The two PWM signals for the two phases are obtained from ePWM module 1. ePWM1A
drives phasel of the PFC while ePWM1B drives phase 2. The quantities that are sensed
and fed back to the MCU include, the rectified input AC voltage (Vrecr ac), the two PFC
phase currents (lpha, lpne), and the boost stage output voltage (Verc our), as was shown
in Fig 3. These quantities are read using the ADC drive module and are shown as
VacLineRect, IphA, IphB and Vpfcout in Fig 7. The ADC driver module converts the 12-
bit ADC result to a Q24 value. A few lines of code in the ISR adds the two individual PFC
phase currents and also accounts for the 0.2V offset on the UCC28070EVM to give the
total PFC input current.

10
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100Khz

PWMDRV_PFC2PhiL:1:

PFCDuty Duty PWM1A 3
PFCShareAd; 0 Adj PWM1B 5
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z=-

S s [ ADCDRV_4ch:1,2,4,5:
Sl
DhEim RIPtrA
£ o

2EEE & |€«— ADC A2

IpfcTotal | €—— S =] ﬁ
£33 = 1 RItPerB A [€— ADCAT1
Eg€2= D
n°s o RIPtrC C |«— ADC A4

VpfcOut &1 RItPtrD l€— ADC A3
100Khz
DLOG_4CH
IpfcTotal i1Ptr buffiPtr —>[[[I[[I[[]] DBUFF1

VacLineRect i2Ptr buff2Ptr DBUFF2
VpfcOut 3Ptr Size buff3Ptr [T DBUFF3

q TrigVal
PFCDuty i4Ptr Prctcalar buff4Ptr DBUFF4

Figure 7. Build 1 software blocks

The PWM signals need to be generated at a frequency of 200 kHz i.e. a period of 5 us.
With the controller operating at 60 MHz, one count of the time base counter of ePWM1
corresponds to 16.6667ns. This implies a PWM period of 5us is equivalent to 300 counts
of the time base counter (TBCNT1). The ePWM1 module is configured to operate in an
up-down count mode as shown in Fig 8, which means a time base period value of 150
will give a total PWM period value of 300 counts (i.e. 5 us) as shown.

For a two phase interleaved boost converter it is advantageous to operate the two
phases 180 deg out of phase. This attenuates the input ripple current to the best
possible extent and also reduces the output capacitor RMS current. Here this is
achieved by configuring ePWML1 as shown in Fig 8.

There is an important consideration regarding where the ADC input is sampled. The
integrity of the ADC input signals is of high importance since this is where signals from
the analog and digital domains interface. Turning a switch ON/OFF in the power stage
may result in some noise or disturbance on the signals that are to be sensed around this
point in time. Even with all the filtering provided on these signals to avoid this noise from
showing up at the ADC inputs, it is prudent to sample the ADC inputs at a time such that
this disturbance is avoided. To achieve this, the ADC input signals are sampled at an
appropriate time so as to get as noise free a sample as possible. For the PFC this is
achieved by sampling at the midpoint of the PWM signal i.e. as far away from the
MOSFET switching as possible. This avoids any switching noise to be reflected on the
ADC result. This is shown in Fig 8. The flexibility of ADC and PWM modules on C2000
devices allow such precise and flexible triggering of ADC conversions. In this case
ePWM2 is used as a time base to generate a start of conversion (SOC) trigger just
before the aforementioned mid-point. A dummy ADC conversion is performed here to
ensure the integrity of the ADC results.

11
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Fig 8 also shows (at a compressed scale) how the PWM duty cycle will correspond to
one quarter of the input AC voltage. Corresponding current is also depicted for one of
the PFC phases.

ePWM1
Time base

ISR
J

ISR PRD = 600 counts (100 KHz)

Ipfc1, Vac_rect

j // Sampled here —

o) v
cPWMIA | CAU CAD CAU Ll

Ipfc2, Vpfcout
// Sampled here —  ———

™
ePWM1B cBU CBD L

4— PWM PRD = 300 counts —¥

15 sys clk
cycles;

g ‘% ePWM2 SOCB

D

— _150 \ //

| ——ePWM2 SOCA

Vacin / /\/\
/\/
Ipfc2 \//\/

Figure 8. PWM generation and ADC sampling

On a CAU event (TBCNT1 = CMPA and counting up), ePWM1A output is Reset, while
on a CAD event (TBCNT1 = CMPA and counting down), ePWM1A output is Set. For
phase 2, on a CBU event (TBCNT1 = CMPB and counting up), ePWM1B output is Set,
while on a CBD event (TBCNT1 = CMPB and counting down), ePWM1B output is Reset.

The CMPA value is derived from the input “PFCDuty” (Q24 variable) command. The
CMPB value is in turn derived from the CMPA value as follows:

CMPB =TBPRD-CMPA 1)
Table 3 gives example CMPA, CMPB values calculated for a TBPRD value of 149.

12
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PFCDuty (Q24) CMPA = CMPB = TBPRD % Duty
(PFCDuty*TBPRD/2"15) ~CMPA

2097152d 18 131 12.4
(0x00200000)

8388608d 75 74 50
(0x00800000)

16776704d 149 0 100
(OXOOFFFEQ0)

Table 3. Duty values for reference
This ensures a 180 deg phase shift between the two PWM signals as shown in Fig 8.

The input “Phadj” can also be used in equation 1 to provide added flexibility to
implement better phase management between the two PFC phases. In this project, this
parameter is always set to ‘0’, such that the commanded duty cycle is always equal for
both phases as shown in Fig 8.

The ADC module is configured to use both SOCA and SOCB of ePWM2 such that,
SOCA is triggered at TBCNT2 = ZERO event while SOCB is triggered at TBCNT2 =
PRD event. At an SOCA event Ipfcl and Vac_rect are sampled and at an SOCB event
Ipfc2 and Vpfcout are sampled as shown in Fig 8. These 4 ADC results are read in the
ISR by executing the ADC driver module in _DPL_ISR.

The assembly ISR DPL_ISR routine is triggered by EPWM1. This is where the
PWMDRYV_PFC2PHIL macros are executed and the PWM compare shadow registers
updated. These are loaded in to the active register at the next TBCNT = ZERO event.
Note that the ISR trigger frequency is half that of the PWM switching frequency as
shown in Fig 8.

Each PFC phase current is sensed by sensing the current through its MOSFET leg.
Thus, only the inductor charging current is sensed. Here, current transformers, with a
turns-ratio of 1:50, and sense resistors (33.2 ohm) sense the current through the two
switches. On this board, there is also an offset of 0.2V added to the current sense signal
(please refer to the UCC28070EVM user guide for a detailed description). This offset
shows up on the ADC input and is accounted for in the software. Please refer to
PFC2PHIL-Calculations.xls file for details on these calculations.

VacLineRect and Vpfcout

Simple voltage dividers are used to sense these two quantities by bringing them within
the 0 — 3.3 V ADC input range.

Protection

At this stage, it is appropriate to introduce the trip mechanism used on this board for the
PFC stage. Here an overcurrent protection is implemented for the two PFC phase

13
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currents. Please note that although no overvoltage protection is implemented here, it is
possible to do so in the software or using external comparator and TZ pins.

The sensed current signals are fed to the ADC inputs that also serve as the non-
inverting input of the two on-chip analog comparators on Piccolo-A. The reference trip
voltage level is set using the internal 10-bit DACs and fed to the inverting terminal of the
comparators. The comparator outputs are configured to generate a one-shot trip action
whenever the sensed current is greater than the set limit. The flexibility of the trip
mechanism on C2000 devices provides the possibilities for taking different actions on
different trip events. In this project both PWM outputs will be driven low in case of a trip
event. Both outputs are held in this state until the trip flag is cleared in the software or a
device reset is executed. Please refer to PFC2PHIL-Calculations.xls file for details on
these calculations.

The key signal connections between the C2000 Controller and the PFC stage are
summarized in the table below.

Signal Name Description Connection to
C2000 Controller
EPWM-1A PWM Duty control signal for PFC phase 1 GPIO-00
EPWM-1B PWM Duty control signal for PFC phase 2 GPIO-01
Ipfcl PFC Phasel current ADC-A2/COMP1A
Vpfcout PFC Output Voltage ADC-A3
Ipfc2 PFC Phase 2 current ADC-A4/COMP2A
Vac_rect Input rectified AC voltage ADC-Al

Table 4. PFC Signal Interface reference

Procedure

Start CCS and Open a Project

To quickly execute this build, follow the following steps:

1. Connect USB connector to the Piccolo controller board for emulation. Power up
the 14 V bias supply at J2. By default, resistors R6 and R7 on the Piccolo Macro
of the control card are removed to enable — boot from FLASH. Re-populate these
resistors to run and program RAM or program FLASH.

2. Double click on the Code Composer Studio icon on the desktop. Maximize Code
Composer Studio to fill your screen. Close the Welcome screen if it opens up.

3. A project contains all the files and build options needed to develop an executable
output file (.out) which can be run on the MCU hardware. On the menu bar click:

14
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Project - Import Existing CCS/CCE Eclipse Project and under Select root
directory navigate to and select ..\controlSUITE\development_kits\HVPFC
2PhiL\PFC2PhiL directory. Make sure that under the Projects tab PFC2PHIL is
checked. Click Finish.

This project will invoke all the necessary tools (compiler, assembler, linker) to
build the project.

In the project window on the left, click the plus sign (+) to the left of Project. Your
project window will look like the following:

BC/C+ - Code Composer Studio (Licensed)

File Edit Wiew Mavigate Project Target Tools Window  Help
=R =) % - ¥ [ croer
=0 = 0| %= outine 52 =0

= q?’ = An outlin is not available,
= =5 PFC2PhiL [Active - F2802x_RAM]
#- € Binaries
= (2 Indudes
H- (= F2802x_FLASH
i (= F2602x_RAM
£ PFC2PhiL-Settings.h
#- [ ADC_SOC_Crf.c
% [¢] Comp_Drvslobalvars.c
%€ DacDrvCnf.c
+ [ DSPZB02x_CodestartBranch. asm
# g DSP2B0Zx_GlobalvariableDefs.c
- [$) DSPZE0Zx_usDelay . asi
- [£] PRCZPHIL-Dev .0
£ PFC2PhiL-DPL-ISR asm
- [€] PRCZPhL-Main.c
5 [ PWM_PFCZPHL_Crf.c
- L& sciCommstui.c [Excluded from Build)
Egy DSP2802x_Headers_nonBIOS cmd
% Fe8027_FLASH_PFCZPHIL.CMD [Exch
] F28027_RAM_PFCZPHIL.CMD
B Qmath.lib
= macros.ini

Device Initialization, Main, and ISR Files

Note:

DO NOT make any changes to the source files — ONLY INSPECT

5.

Open and inspect PFC2PHIL-Devinit_F2802x.c by double clicking on the
filename in the project window. Notice that system clock, peripheral clock
prescale, and peripheral clock enables have been setup. Next, notice that the
shared GPIO pins have been configured.

Open and inspect PFC2PHIL-Main.c. Notice the call made to Devicelnit()
function and other variable initialization. Also notice code for different incremental
build options (specifically the build you are going to compile now), the ISR
intialization and the background for(;;) loop.

Locate and inspect the following code in the main file under initialization code
specific for build 1. This is where the PWMDRYV_PFC2PhiL block is connected
and initialized in the control flow.

15
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4 Lib Module connection to "netzs"

ff Connect the PWM Driver input to an input wariable, Open Loop System
PUWMDEY PFCZPhil Dutyl EPFCDuty:
PUWMDEY PFCZPhil Adjl LSPFCSharedd]:

8. Locate and inspect the following code in the main file under initialization code
specific for build 1. This is where the ADCDRV_4CH block is configured,

initialized and connected in the control flow.

#define IpfeiR AdcResult. ADCRESTLTL £
f#idefine Vac_recth AdcEesult. ADCRESTLTZ A
#define IpfozR AdeResult. ADCRESTLT4S £
#define WpfeOuth LdecResult. ADCRESTULTS £

ff ADC Channel Selection for Configuring the ADC
//Map channel to ADC FPin

Ch3el[O] = 2: f4 A2 - PFC Phazsel current - Dummy read
Ch3el[1] = Z: /4 hZ - PFC Phasel current - IpfecR1
ChSel[2] = 1: {f Al - VacLine Rect - Vaco rectR
ChSel[3] = 4: /4 24 - PFC PhaseZ current— Dummy read
ChSel[4] = 4: 44 a4 - PFC PhaseZ current — IpfcR2
ChSel[5] = 3: £ b3 - PFC O/P Woltage - Vpfc outR

/¢ Select Trigger Event

Trig3el[0] = ADCTREIG EPWMZ 30CA4; /¢ PFC Phase 1 current sampling triggered by EPWNZ
Trigdel[l] = ADCTRIG_EPWMzZ_ Z0CA; /¢ PFC Phase 1 current sampling triggered by EPWHNZ
TrigSel[2] = ADCTREIG _EPWMz S30CL; /7 WacLine Rect sampling triggered by EPWMZ S0CL
Trig3el[3] = ADCTRIG EPWMZI_ 30OCE; /¢ BFC Phase 2 current sampling triggered hy EPTHME
TrigSel[4] = ADCTRIG _EPWMzZ SZ0OCE: /¢ PFC Phase 2 current sSawmpling triggered by EPWHZ
Trig3el[5] = ADCTRIG _EPWM:Z S0OCE; /4 PFC OfP wvoltage sampling triggered by EPWMZ S0CE

/f Configure PWM1 with TEPRD of 300 olock cyoles, in master mode
PWM_PFCZPHIL CNF (1, 300); // for 200 Khz swicthing frequency
PWM_PFCZPHIL_CNF (2, 300); // ePUM2 used for ALDC Trigger

Af Zyne PUMZ with PWH1 with s phase shift = time reguired for one ADC dwrmmy conversion
EFwmZRegs. TBCTL.bit .PHSEN = TBE_ENABLE;

EPvmzRegs.TECTL.bit .PHSDIR = TE_UF;

EPwmzZRegs. TEPHS . half. TEPHS = 15:

ADC_30C_CHNF (Ch3el, Trigdel, ACQPS, 15,0];

/¢ Configure the Jtart of Conversion for the ADC, ePWMZ is the trigger.

f¢ At TBCHNTL = 0 convert Ipfcl and Vacline and TECHMT1 = PRD convert IpfoZ and Vpfocout
J7 At TECHNTL = 0 30CL i= triggered and at TECHT1 = PRD S0OCE i= triggered
EPymZPRegs . ETSEL.kLit . SOCAEN = 1;

EFwmmZRegs.ETSEL.bit . 30CASEL = ET_CTR_ZERQ: // Use EZRD event as trigger
EPwmZRegs.ETPS.bit.S0CAPRD = ET_ZND; /4 Generate pulse on Znd ewvent

EPvmZRegs.ETSEL.bit . 30OCEEN = 1;
EPwmiBeys.ET3EL.bic . JOCESEL = ET CTR_PRD: /4 Use PRD event as trigger as well
EPwmzZRegs.ETPS.Lit.30CEPRD = ET 2ND: /¢{ Generate pulse on Znd ewvent

//ADCDRU_&CH hlock output conhections
ADCDEV_4ch RItPtrd = &Iphd;
ADCDRV_4ch RloPtrB = &VacLineRect;
ADCDRV_4ch RItPtrC = &£IphE:
ADCDRV_4ch RItPtrD EVpfoout;

SOCL
SOCL

30CE
SOCB

9. Open and inspect PFC2PHIL-DPL-ISR.asm. Notice the _DPL_Init and
_DPL_ISR sections. This is where the PWM and ADC driver macro instantiation
is done for initialization and runtime, respectively. Optionally, you can close the

inspected files.
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Build and Load the Project
10. Select the Incremental build option as 1 in the PFC2PHIL-Settings.h file.

Note: Whenever you change the incremental build option in PFC2PHIL-
Settings.h always do a “Rebuild All”.

11. Click Project->"Rebuild All” button and watch the tools run in the build window.

12. Click Target->"Debug Active Project”. CCS will ask you to open a new Target
configuration file if one hasn't already been selected. If a valid target
configuration file has been created for this connection you may jump to Step 14.
In the New target Configuration Window type in the name of the .ccxml file for the
target you will be working with (Example: xds100-F28027.ccxml). Check “Use
shared location” and click Finish.

13.In the .ccxml file that open up select Connection as “Texas Instruments
XDS100v2 USB Emulator” and under the device, scroll down and select
“TMS320F28027". Click Save.

14. Click Target->"Debug Active Project”. The program will be loaded into the FLASH
or RAM memory depending on the project configuration selected (Default
configuration is F2802x_FLASH, which will be used for this exercise. Please refer
to the note below if you want to change the project configuration). You should
now be at the start of Main().

NOTE: When wusing a certain project configuration (F2802x_RAM/
F2802x_FLASH), please make sure you change the following lines of code in
PFC2PHIL-Main.c file appropriately:

#define DLOG_SIZE 256 // Uncomment for FLASH configuration only
//#define DLOG_SIZE 32 // Uncomment for RAM configuration only

We will be using the FLASH configuration option for this exercise.

Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code.
There are various methods for doing this in Code Composer Studio, such as memory
views and watch views. Additionally, Code Composer Studio has the ability to make
time (and frequency) domain plots. This allows us to view waveforms using graph
windows.

15. If a watch view did not open when the debug environment was launched, open a
new watch view and add various parameters to it by following the procedure
given below.

Click: View = Watch on the menu bar.

Click the “Watch (1)" tab at the top watch view. You may add any variables to
the watch view. In the empty box in the "Name" column, type the symbol name of
the variable you want to watch and press enter on keyboard. Be sure to modify
the “Format” as needed. The watch view should look something like the
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16.

following. Please note that some of the variables have not been initialized at this
point in the main code and may contain some garbage values.

= wyatch (1) X = R O R
Value Address Tvpe Farmat
= PRty -91 . 4622727 0x0000507A@Data long Q-Value(24)
= Gui_vpfeout 0.0 000003004 @0aka ink Q-Yaluela)
9= Gui_Tpfcl 0.0 0x000023000@0aka it Q-Yalue(12)
(=)= Gui_Ipfc2 0.0 000005001 @Daka ink Q-Yaluel12)
()= Gui_IpfcTotal 0.0 0:x0000300B@Daka ink Q-Yalue(11)
)= IpFeTatal -26.5518865 0:00008074@Daka long Q-Valuelz4)
)= FaultFlg 15189 0x00005010@0ata int Matural
)= ClearFaultFlg 24843 0x00008005@0aka ink Matural
(9= ComplReqgs.DACYAL bit.DACYAL O 0:00006406@0aka (unsigned ink:6:10)  Matural
= Comp2Regs. DACYAL bit.DACYAL O Ox0000&6426@Data (unsigned int:6:10)  Matural
= @ui_dlog_trig 0.0 0:00008024@0aka ink G-Yaluel15)
[ — | — | —| ———}

Figure 9. CCS watch view for Build 1

FaultFlg, if set, indicates a PFC over current condition (discussed above). The
trip mechanism immediately shuts down the two PWM outputs in such a case.
The PWM outputs are held in this state until a device reset (follow the proper
procedure in Step 31) or until ClearFaultFlg is set in the watch view. The
CompxRegs.DACVAL.bit. DACVAL directly set the internal 10-bit DAC reference
level for the on-chip comparators. Please note that this is a 10-bit (Q10) number.

Open two graph windows by clicking Tools > Graph - Dual Time. These are
dual time graph windows to plot the four data log buffers DBUFF1, DBUFF2,
DBUFF3 and DBUFF4. Set the graph properties for the two graphs as shown
below. Please note that when using the F2802x_RAM project configuration the
Acquisition Buffer Size and Display Data Size should be changed to 32. For the
F2802x_FLASH configuration a value of 256 is used for these fields as shown
below.
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Graph Properties EJ Graph Properties EI

Property Value Property Value
=l Data Properties =l Data Properties
Acquisition Buffer Size 256 Acquisition Buffer Size 256
Dsp Data Type 16 bit unsigned integer Dsp Data Type 16 bit unsigned integer
Index Increment 1 Index Increment: 1
Interleaved Data Sources [ False Interleaved Daka Sources [ False
Q_Walue 1] Q_Walue [1}
Sampling Rate HZ 1 Sampling Rate HZ i
Start Address & DELFF1 Start Address A DEUFF3
Start Address B DELFF2 Start Address B DEUFF4
=l Display Properties =l Display Properties
Axis Display v true Axis Display | true
Data Plok Style Line Data Plot Style Line
Display Data Size 256 Display Data Size 256
Grid Style Major Grid Grid Style Marjor Grid
Magnitude Display Scale  Linear Magnitude Display Scale  Linear
Time: Display Unit sample Tirne: Display Unit sample
Use Dc Yalue For Graph & [ ] False Use Dt Yalue For Graph & [ ] False
Use Dt Walue For Graph B[] false Use Dt Walue For Graph B[] false
[ Import ] [ Export ] [ [a]4 ] | Cancel | [ Import ] [ Export ] [ [s]4 ] | Cancel |
Using Real-time Emulation
Real-time emulation is a special emulation feature that allows the windows within Code
Composer Studio to be updated at up to a 10 Hz rate while the MCU is running. This not

only a

llows graphs and watch views to update, but also allows the user to change values

in watch or memory windows, and have those changes affect the MCU behavior. This is

very u
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18.

19.
20.

21

seful when tuning control law parameters on-the-fly, for example.

. Enable real-time mode by hovering your mouse on the buttons on the horizontal

’j\:} Enable Silicon Real-time Mode (service critical interrupts when halted, allow

toolbar and Clicking L debugger accesses whils running] button.

A message box may appear. If so, select YES to enable debug events. This will
set bit 1 (DGBM bit) of status register 1 (ST1) to a “0”. The DGBM is the debug
enable mask bit. When the DGBM bit is set to “0”, memory and register values
can be passed to the host processor for updating the debugger windows.

. o H . .
Now click B¥ Enable Palite Real-time Mode button on the same horizontal toolbar.

When a large number of windows are open, as bandwidth over the emulation link
is limited, updating too many windows and variables in continuous refresh can
cause the refresh frequency to bog down. Right click on the = button in the
watch view and select “Customize Continuous Refresh Interval..”. You can slow
down the refresh rate for the watch view variables by changing the Continuous
refresh interval (milliseconds) value. A rate of 4000 ms is usually enough for
these exercises.

. Click on Continuous Refresh buttons & for the watch view and the graphs.
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Run the Code

22. Run the code by using the <F8> key, or using the Run button on the toolbar, or
using Target - Run on the menu bar.

23. In the watch view, the variable PFCDuty should be set to 0.0. This variable sets
the duty cycle for the two phases of PFC boost converter as shown in Table 3.

24. Apply an appropriate resistive load to the PFC system at the DC output.

NOTE: For safety reasons it is recommended to use an appropriate isolated
AC source.

25. Power the AC input with an AC input voltage within the abilities of the board.

26. Increase the duty cycle by setting PFCDuty to a higher value 0.04(say) in the
watch view. (Refer to Table 3 for correspondence of different duty values with
PFCDuty). The boost converter should now start boosting the input voltage.

Observe the output voltage carefully, this should not be allowed to exceed
the capabilities of the board.

27. Observe the different ADC results in the watch view and the graph windows for
different duty cycle values. You may have to adjust the “Gui_dlog_trig_value” in
the watch view for the graphical display. Data logging is triggered with respect to
DBUFF1 (IpfcTotal). A good approximation for “dlog_trig_value” (in Q15) is to
make it close to the IpfcTotal value (in Q24).

28. Here are the watch view and graph windows that correspond to the operation of
the system with a PFCDuty command of 0.2 per unit (Q24) with the input voltage
of around 125Vac and a resistive load of around 1200 ohm. DualtimeA-O
corresponds to IpfcTotal(Q15), DualtimeB-0 corresponds to VacLineRect(Q15),
DualtimeA-1 corresponds to VpfcOut(Q1l5) and DualtimeB-1 corresponds to

PFCDuty(Q15).
]
Mame Value Address Type Format
(9= PFCDuky 0.1999999551 Oex00008674@0ata long Q-Value(24)
(= Gui_WpFoout 214,938 Ox00003604@0aks int Q-value(B)
9= Gui_Ipfct 0.253174 0x00008600@0ata int G-¥alue(12)
)= Gui_Ipfc2 0.261719 Ox00008601@0ata int Q-alue(12)
(4= Gui_IpfcTotal 0.535645 0x0000360B@0aka int Q-Walue(11)
9= IpFcTotal 0.04330444336  Ox0000867A@0ata long Q-Walue(24)
)= FaultFlg 0 0x00005612@0ata int Matural
)= ClearFaultFlg 1] (0x00003605@0ata int Tatural
()= ComplReqgs.DACYAL. bt DACYAL 989 0x00006406@Daka {unsigned int:6:10) Matural
(= Comp2Reqgs.DACYAL.bit. DACYAL 989 0x00006426@0aka {unsigned ink:6:10) Matural
)= Gui_dlog_trig 0.00299072 00000862 1@0ata int Q-value(15)
<nzvi= |
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29. The following oscilloscope captures show the input line voltage and current seen

under the conditions described above.

Std Dev
4.79m

| Value Mean Min Max
| @D CycleRMS 124 V 124 124 124

.oms
v452.000us ||

30. Try different duty cycle values and observe the corresponding ADC results.
Increase duty cycle value in small steps. Always observe the output voltage
carefully, this should not be allowed to exceed the capabilities of the board.
Different waveforms, like the PWM gate drive signals, input voltage and current
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31.

32.

and output voltage may also be probed using an oscilloscope. Appropriate safety
precautions must be taken while probing these high voltage, high power signals.

Fully halting the MCU when in real-time mode is a two-step process. With the AC
input turned off wait a few seconds. First, halt the processor by using the Halt

button on the toolbar, or by using Target - Halt. Then click clicking o button
again to take the MCU out of real-time mode and then reset the MCU.

You may choose to leave Code Composer Studio running for the next exercise or
optionally close CCS.

End of Exercise
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3.2
>

Build 2: Full PFC
Objective

The objective of this build is to verify the operation of the complete PFC project from the
CCS environment.

Overview

Fig 10 shows the software blocks used in this build. Two pole two zero controllers are
used for the current and voltage loops. Depending on the application’s control loop
requirements some other controller block like a PI, a 3-pole 3-zero, etc may also be
used. As shown in Fig 10 the current loop control block is executed at a 100 KHz rate,
while the voltage loop is executed at half of this rate at 50 KHz. CNTL2P2Z is a 2" order
compensator realized from an IIR filter structure. This function is independent of any
peripherals and therefore does not require a CNF function call.

50Khz
100Khz
CNTL_2P2Z:1:

’W 100Khz 100Khz
0 Vem CNTL_2P22:2: PWMDRV_PFC2PhiL:1:
4 R

VpfcSetSlewed 0 Ref

Out o VpfcVemd

VpfcOut

Note VpfcOut is calculated by
the ADCDRV_4ch

6 Fdbk

DBUFF PWM1A 3

2z

PWM1B >

100Khz

o RIPIrA ADC A2

100Khz

O RItPHB <«— ADCA1

PFC_INVSQR:1:

CFS

& RItPC

o}

[€— ADC A4

& RItPrD [«— ADC A3

Multiplier

100Khz

100Khz

DLOG_4CH MATH_EMAVG:2:

IpfcTotal TP buffiPtr — >IN DBUFF1
i2Ptr buff2Ptr G——»{[IIIIII DBUFF2
butf3Ptr G—> [T DBUFF3

Size
TiigVal butfiPtr —>| DBUFF4
ey buff4Ptr G I

VacLineScaled Out n

Piclemd

PFCDuty 5

Figure 10. Build 2 software blocks

The five coefficients to be modified are stored as the elements of structures
CNTL_2P2Z_CoefStructl and CNTL_2P2Z_CoefStruct2 along with the output clamping.
The CNTL_2P2Z block can be instantiated multiple times if the system needs multiple
loops. Each instance can have separate set of coefficients. The CNTL_2P2Z instance
for the current loop uses the coefficients stored as the elements of structure
CNTL_2P2Z CoefStruct2, while the instance for the voltage loop uses the coefficients
stored as the elements of CNTL_2P2Z CoefStructl. Directly manipulating the five
coefficients independently by trial and error is almost impossible, and requires
mathematical analysis and/or assistance from tools such as matlab, mathcad, etc.
These tools offer bode plot, root-locus and other features for determining phase margin,
gain margin, etc.

To keep loop tuning simple and without the need for complex mathematics or analysis
tools, the coefficient selection problem has been reduced from five degrees of freedom
to three, by conveniently mapping the more intuitive coefficient gains of P, | and D to BO,
B1, B2, Al, and A2. This allows P, | and D to be adjusted independently and gradually.
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These mapping equations are given below. For the current loop these P, | and D
coefficients are: Pgain_lI, Igain_I and Dgain_|I respectively. For the voltage loop these P,
I and D coefficients are: Pgain_V, Igain_V and Dgain_V respectively. These P, | and D
coefficients are used in Q26 format. To simplify tuning from the GUI environment (or
from CCS watch views) these three coefficients are further scaled to values from O to
999 and the corresponding P, | and D GUI gain variable is used. In the lab exercise, you
will inspect the C code in which these coefficients are initialized.

The compensator block (CNTL_2P2Z) has 2 poles and 2 zeros and is based on the
general IIR filter structure. It has a reference input and a feedback input coming from
the ADC. For the current loop the feedback is the total PFC input current IpfcTotal. For
the voltage loop the feedback is the output voltage VpfcOut. The transfer function is
given by:

U(z) _ botbiz " +baz?
E(Z) l+aizt +a2z7

The recursive form of the PID controller is given by the difference equation:

u(k)=u(k —1)+boe(k )+ bre(k —1)+ bze(k — 2)

where:
bo = Kp'+Ki'+Kad'
b1 = —Kp'+Ki'—2K4'
b2 = Kd'

And the z-domain transfer funcion form of this is:
U(Z) botbiz +boz?  boz’+biz+bs

E(z) 1-z7 7’ -1

Comparing this with the general form, we can see that PID is nothing but a special case
of CNTL_2P2Z control where:

ai=-1 and a2=0

The MATH_EMAVG (Exponential Moving Average) block calculates the average of the
input rectified AC voltage. The Inverse average square (PFC_INVSQR) block normalizes
this average value with its own (AC input) maximum. The PFC_INVSQR block also
provides a feed-forward compensation so as to maintain a constant output power for a
given load by appropriately responding to changes in the input AC voltage. For example
for a constant load if the input voltage decreases INV SQR block output increases
proportionately. This block drives the PFC current command block (PFC_ICMD).
Therefore, an increase in the PFC_INVSQR block output in turn increases the current
command, which leads to an increase in the input current so as to maintain the same
power level.

Implemented in the .asm file (ISR code) is a gain on the VacLineRect variable such that
the maximum input voltage of 285V on this board is scaled to 0 to 32767d in Q15 format
(or 0 to 16776704d in Q24) for the variable VacLineScaled. This is done in order to scale
the possible input voltage range to the full Q24 format range before applying it to the

24
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other mathematical blocks. After applying this gain the maximum possible input voltage
on this board will correspond to a value of Ox7fff (32767d) for the variable
VacLineScaled in Q15 format.

The PFC current command block is responsible for calculating the current command
required for the power factor correction. Its output is half-sinusoidal with an amplitude
proportional to the commanded voltage. The voltage controller output sets the voltage
command for the PFC_ICMD block. The output of the PFC_ICMD block drives the
current controller.

Improving Input p.f. and T.H.D. under High-line and Low-load Conditions

In this implementation the ADC inputs are sampled once in each switching cycle. As
mentioned in the previous chapter these inputs are sampled at the mid-point of the ON
time so as to get as noise free a signal as possible. The two PFC phase currents are
also measured in the same way. An advantage of this way of sensing is that when the
PFC stage is operating in continuous conduction mode, the current measured this way
gives an average input current measurement (assuming a linear charging-discharging
inductor current).

Under high-line and low-load conditions the input current stays discontinuous for a
longer portion in each sine quarter of the input line voltage. The lower the load or higher
the input rms voltage, the longer the PFC stage operates in discontinuous conduction
mode (DCM) in each sine quarter of the input line voltage. The amount of time the
system operates in DCM mode is dependent on the inductor and the power stage design
and the line-load conditions. During this time of operation (DCM) the sensed current is
not equal to the average (averaged over one switching cycle) current. In fact this
measured current is greater than the average. This difference in the measured average
and true average current is greater for duty cycle and line-load conditions when
operating in deep DCM mode. Therefore the current loop feedback input is higher than
the set reference input. Consequentially the controller drives a smaller control
action/duty cycle where a higher duty cycle is required. This results in a distorted input
current waveform during the period of DCM operation in each quarter cycle and possibly
a jump in the input current during the input voltage sine quarter when the input current
crosses DCM-CCM mode boundary and vice-versa. Apart from reducing the input power
factor (p.f.) and increasing the total harmonic distortion (T.H.D.), a side effect of this
behavior is a possible reduction in the efficiency of the system under these high-line and
low-load conditions.

In this implementation, to compensate for the difference between the measured and true
average current values under different line-load conditions a compensating factor is
subtracted from the measured current. This factor is estimated to vary in an inverse-sine
fashion with the input line voltage. This is because around the zero crossing of the input
line voltage the discrepancy between the measured and true average current seems to
be the largest, while it is minimum at the peak of the line voltage. The amplitude of this
inverse-sine (CompAmpltd) is dependent on the different line-load conditions (input rms
voltage and power drawn). The higher the line or lower the load, the higher is the
CompAmpltd value. Thus the largest CompAmpltd values correspond to the high-line
and low-load operation. This way of compensation also helps improve the system
efficiency under different operating conditions.

25
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In this implementation following equation was used to calculate the CompAmpltd. Please
note that this equation was arrived at by way of experimentation.

CompAmpltd = (Input_Power(Max) - Input_Power)*Scale_Factor*(Vacms) - 85)/(285-85)

where,

CompAmpltd = the amplitude of the inverse-sine compensation

Input_Power(Max) = Maximum input power rating (~312VA)

Input_Power* = Input Power calculated from r.ms. input current and r.m.s input
voltage measurement.

Scale_Factor = this factor is a function of the line voltage. Here different values
are used for different input line voltage ranges. These ranges may
be increased decreased for increased granularity.

(Vacms) - 85)/(285-85) = this factor is a normalizing factor for the input line voltage

within its range of operation from 85V — 285V AC.

These calculations are performed in the slower state machine task B3. Please note that
this is only one way of implementation and an approximate equation that seems to work
well for the power stage used here. Other better functions and equations based on the
inductor and power stage designs and Mathcad and Matlab simulation tools are certainly
possible to provide better results and granularity.

Adding a Shoulder

When operating under high-line low load conditions, it is likely that the PWM switching
around the input voltage zero crossing may contribute more to switching losses than be
useful for power factor correction action. It may also be the case that efficiency is a
major concern under certain operating conditions than achieving the very small power
factor increases that may be obtained by driving duty cycle around the zero voltage
crossing points. Therefore, it might be advantageous to not drive the two switches
around the zero crossing. A factor shoulder is used to make the duty cycle zero for input
voltages below a certain level defined by this value. Higher the line voltage and lower the
load, higher the shoulder value. Please note that a large shoulder value may result in a
huge jump in the input current when the input voltage goes above this value. Also, the
calculated r.m.s. input voltage will be smaller than actual.

' The input power calculated here is based on r.m.s values calculated from average
values obtained using moving average filters for the input current and input voltage.
Better results may be obtained by implementing true r.m.s calculations for input voltage
and current to obtain better granularity and possibly better results across the whole line-
load range.
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Start-up, Shut-down and Slew-limit

At start-up if the input line voltage is above ~ 115V r.m.s. for greater than ~ 1.5 secs the
PFC action is enabled and the output will ramp up to the desired value of ~ 390Vdc. This
ramp up speed is defined by the slew limit block implemented in the slower state
machine task C3. Further, the current controller output is clamped and this clamping limit
is also ramped up slowly at start-up to ensure smooth start-up operation. Whenever the
input voltage falls below ~ 90V the PFC action is immediately disabled and not enabled
till the input voltage falls in the acceptable range and stays good for more than 1.5 secs.
As such please note that this mechanism prevents a one cycle input voltage drop-out
operation. This part of the software, among other things, is required to be changed if
such an operation is desired.

Procedure

Build and Load Project

To quickly execute this build using the pre-configured work environment, follow the
following steps:

1-2. Follow Steps 1 to 2 exactly as in build 1. If you were working on build 1 the last
time CCS was used, the same workspace should open up with the project. If this
is not the case, you can open the workspace used for build1l by clicking File >
Switch Workspace and then navigating to the correct workspace. If a workspace
was not saved or got deleted, please follow steps 3 and 4 exactly as in buildl.

3. Locate and inspect the initialization code specific to build 2 in the main file. This
is where all the control blocks are configured, initialized and connected in the
control flow.

4. Select the Incremental build option as 2 in the PFC2PHIL-Settings.h.

Note: Whenever you change the incremental build option in PFC2PHIL-
Settings.h always do a “Rebuild All".

5. Click Project>“Rebuild All” button and watch the tools run in the build window.

6. Click Target->"Debug Active Project”. The program will be loaded into the
FLASH or RAM memory depending on the project configuration selected (Default
configuration is F2802x_FLASH, which will be used for this exercise). You should
now be at the start of Main().

NOTE: We will be using the F2802x_FLASH configuration option for this
exercise. It is important to make the appropriate changes to the code for the
configuration being used, as mentioned in Step 14 of Build 1.

Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code.
There are various methods for doing this in Code Composer Studio, such as memory
views and watch views. Additionally, Code Composer Studio has the ability to make
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time (and frequency) domain plots. This allows us to view waveforms using graph
windows.

7.

If a watch view did not open when the debug environment was launched, open a
new watch view and add various parameters to it by following the procedure
given below.

Click: View = Watch on the menu bar.

Click the “Watch (1)" tab at the top watch view. If a watch view is already open
from the debug environment saved for build 1, click on [iNew \Watch View button in
the watch view. A “Watch (2)” tab will open and you may then drag it to be
viewed in a window of your choice. You may add any variables to this watch view
tab. In the empty box in the "Name" column, type the symbol name of the
variable you want to watch and press enter on keyboard. Be sure to modify the
“Format” as needed. The watch view should look something like the following.
Please note that some of the variables have not been initialized at this point in
the main code and may contain some garbage values.

Address Format
= Gui_tpfcSet . Ox00003625@0ata ink Q-aluels)
= Gui_vpfcout . 0x00003604@0ata int Q-Yalues)
= Gui_Yaclinefyg . 0x00003602@Data ink Q-Valuels)
= Gui_Ipfcl ; 0x00003600@D ata ink Q-Value(12)
= Gui_lpfc2 : 000008601 @Data ink Q-Malue(12)
= Gui_IpfcTotal 0x00003860B@0ata ink Q-Value(11)
= Gui_Ipfc_awa Ox00003609@0ata ink Q-aluell)
= Itrip_lewel 0x0000361E@Data int Matural
= Input_Power ; 0x0000360F@Data ink Q-valuelz)
= auto_compensate O0x0000360C@Data ink Tatural
= Gui_shoulder 0x0000362%9@0ata int Tatural
= Gui_Compampltd 0x0000360A@0ata ink Matural
= Gui_Setshoulder Ox00003e22@Data ink atural
= Gui_SetCompAmpltd Ox0000362A@Data ink Matural
= Gui_Pgain_I Ox00005624@0ata ink Tatural
= Gui_Igain_I 0x000053623@0ata ink Matural
= Gui_Dgain_I 0x00008625@0ata ink Matural
= Gui_Pgain_Y 0x00008619@0ata ink Matural
= Gui_Igain_Y 00000261 A@0ats ink atural
= Gui_Dgain_Y Ox00005615@0ata ink Tatural
= FaulkFlg Ox00005610@0ata ink Matural
= ClearFaultFlg Ox00003605@0ata ink Tatural
0x00008621@Data ink Matural

= Gui_dlog_trig

u]

Figure 11. CCS watch view for Build 2

Notice the additional variables in the watch view. Itrip_level is a Q15 number and
sets the DAC reference level for the two comparators. The default value
corresponds to a current trip level of 4.5A. Input_Power is the estimated input
power based on average input current and average input voltage calculated
using exponential moving average blocks. The GUI variables for the P, | and D
gains of the current and voltage loops are in a scaled format and have a range of
0 to 999. It is extremely important that these values be never changed to values
outside this range.
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8.

10.

Notice the variable auto_compensate in the watch view. When this parameter is
set to 1 (default) the algorithm calculates the CompAmpltd (Q30) and shoulder
(Q24) values on its own depending on the line-load conditions. A value of O for
auto_compensate lets the user set the CompAmpltd and shoulder values using
the variables Gui_SetCompAmpltd (Q15) and Gui_Setshoulder (Q15)
respectively. This provides for an easy means to experiment with/without this
compensation mechanism. Gui_CompAmpltd and Gui_shoulder variables allow
the CompAmpltd and shoulder values to be viewed in Q15 format.

If the graph windows used in build 1 don’t open correctly, then create new graph
windows exactly as in step 16 of build 1.

We'll use Gui_VpfcSet and Gui_Vpfcout to set the voltage command and read
the output voltage instead of the Q24 variables VpfcSet and VpfcOut.

Run the Code

11.

12.

13.

14.

Follow steps 17 to 21 of build 1 procedure to enable real time mode and
continuous refresh for the watch views and graph windows and also for changing
the continuous refresh interval for the watch view.

Run the code by using the <F8> key, or using the Run button on the toolbar, or
using Target - Run on the menu bar.

Apply an appropriate resistive load to the PFC system at the DC output
(Resistive loads above 80W and below 300W are recommended).

Power the AC input with an AC input voltage within the abilities of the board
(110Vac to 230Vac is recommended).

NOTE: For safety reasons it is recommended to use an appropriate isolated
AC source.

Once the system is running in realtime and is powered with the AC input, observe
the measured output voltage (Gui_Vpfcout). The PFC output should ramp according
to the slew rate to the desired set value (~385Vdc). The power factor correction
should be maintained during this process.

15.

Here are the watch view and graph windows that correspond to the operation of
the system with the input voltage of around 120Vac and a resistive load of
around 700 ohm. You may have to adjust the “Gui_dlog_trig_value” in the watch
view for the graphical display. DualtimeA-O corresponds to IpfcTotal(Q15),
DualtimeB-0 corresponds to VacLineScaled(Q15), DualtimeA-1 corresponds to
PFClcmd(Q15) and DualtimeB-1 corresponds to PFCDuty(Q15).
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Local (1) | Watch (1)
Marne

()= Gui_VpfcSet

(9= Gui_VpFoOut

()= Gui_Vaclinefwg

(9= Gui_Ipfcl

9= Gui_Ipfcz

(<= Gui_IpfcTatal

{x)= Gui_IpFc_ava

9= Ttrip_lewel

(9= Input_Power

(%)= auto_compensate

=)= Gui_shoulder

9= Gui_Compampltd

()= Gui_3etshoulder

()= Gui_SebCompampltd

()= Gui_Pgain_I

(9= Gui_Igain_I

(2= Gui_Dgain_I

(=)= Gui_Pgain_Y

(4= Gui_Igain_V

(9= Gui_Dgain_Y

(=)= FaultFlg

(%)= ClearFaultFlg
Gui_dlog_trig

= P @I T

Yalue
3.0
352,641
117,906
0.883057
0,900391
1.87109
1.7876
29669
21275
1
200
=]

address
0=00003625@0ata
Dx000058604@0ata
Ox000053602@0ata
0x00003600@0ata
Dx00003601@bata
0x0000360B@0Data
0x00003609@Data
0=0000361E@bata
0x0000860F@0ata
000003608 @0ata
0x0000362%@0ata
D=00003608@0ata
0x00005622@0ata
000003628 @0ata
0x00003624@0ata
00000362 3@bata
0x00003625@Data
00000361 9@Data
O=0000361A@0ata
0x0000561 5@0ata
0x00003610@Data
0x00003605@0ata

Format
Q-Yalue(a)
Q-valus(h)
Q-Walus(a)
-value(12)
O-value(1z)
O-Walusf11)
O-Waluef11)
Makural
O-alusiZ)
Matural
Matural
Takural
Matural
Matural
Matural
Matural
Matural
Matural
Makural
Matural
Matural

Matural
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16. The following oscilloscope captures show the input line voltage and current seen
under the conditions described above is shown in Fig 12. This clearly illustrates
the PFC action.
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Figure 12. Scope capture of Input current and voltage waveforms for Build 2
(Output Power ~ 211W — Input Voltage ~ 120Vac)

Observe the effect of varying the input voltage on the output voltage and input
current. There should be virtually no effect on the output voltage. Also the power
factor correction should be maintained.

Similarly observe the effect of varying the load. Again there should be virtually no
effect on the output voltage and the power factor correction should be
maintained.

Fully halting the MCU when in real-time mode is a two-step process. With the AC
input turned off wait a few seconds. First, halt the processor by using the Halt

button on the toolbar, or by using Target - Halt. Then click clicking o button
again to take the MCU out of real-time mode and then reset the MCU.

Close CCS.

End of Exercise
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References

For more information please refer to the following guides:
e HVPFC2PHIL-GUI-QSG — gives an overview on how to quickly demo the HVPFC project
using an intuitive GUI interface.
.\controlSUITE\development_kits\HVPFC2PhiL \~Docs\HVPFC2PHIL-GUI-QSG.pdf
e HVPFC2PHIL — provides detailed information on the PFC2PHIL project within an easy to
use lab-style format.
.\controlSUITE\development_kits\HVPFC2PhiL\~Docs\HVPFC2PHIL.pdf

e HVPFC2PHIL-Calculations — a spreadsheet showing a few of the key calculations made
within the PFC2PHIL project.

.\controlSUITE\development_kits\HVPFC2PhiL\HVPFC2PHIL-Calculations.xlIs

e HVPFC2PHIL_Rel-1.0-HWdevPkg — a folder containing various files related to the
Piccolo-A controller card schematics.

.\controlSUITE\development_kits\HVPFC2PhiL\HVPFC2PhiL_HWDevPkg

e UCC28070EVM power board related useful files found at
http://focus.ti.com/docs/toolsw/folders/print/ucc28070evm.html| —

> HPA225A - Gerber files for the EVM mother board
» User Guide - UCC28070, 300-W Interleaved PFC Pre-Regulator (Rev. B)

e F28xxx User's Guides
http://www.ti.com/f28xuserquides
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http://focus.ti.com/docs/toolsw/folders/print/ucc28070evm.html
http://www.ti.com/litv/zip/sluc110
http://www.ti.com/litv/pdf/sluu312b
http://www.ti.com/f28xuserguides
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